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Executive summary
The European Space Agency (ESA) Climate Change Initiative (CCI) is a global monitoring program
that aims to provide long-term satellite-based products to serve the climate modelling and climate data
user community. Permafrost has been selected as one of the Essential Climate Variables (ECVs) that
are elaborated during Phase 1 of CCI+ (2018-2021). As part of the Permafrost_cci baseline project,
ground temperature and active layer thickness were considered to be the primary variables that require
climate-standard continuity as defined by the Global Climate Observing System (GCOS). Permafrost
extent and zonation are secondary parameters, but of high interest to users. The ultimate objective of
Permafrost_cci is to develop and deliver permafrost maps as ECV products primarily derived from
satellite measurements. Algorithms have been identified, which can provide these parameters by
ingesting a set of global satellite data products (Land Surface Temperature LST, Snow Water
Equivalent SWE, and Landcover) in a permafrost model scheme that computes the ground thermal
regime. Annual averages of ground temperature and annual maxima of thaw depth (active layer
thickness) were provided at 1 km spatial resolution during Year 1 of Permafrost_cci. The data sets
were created from the analysis of lower level data, resulting in gridded, gap-free products.
In periglacial mountain environments, the permafrost occurrence is patchy, and the preservation of
permafrost is controlled by site-specific conditions. Three options initiated within CCN1 and CCN2
address the need for additional regional cases in cooperation with dedicated users in characterizing
mountain permafrost as local indicator for climate change and direct impact on the society in
mountainous areas. Started in October 2018, CCN1 is led by a Romanian team focusing on case
studies in the Carpathians. The specific objective of CCN1 is to develop and deliver maps and
products for mountain permafrost, such as (i) rock glacier inventories, (ii) rock glacier kinematic time
series of selected rock glaciers and (iii) a permafrost distribution model, primarily derived from
satellite measurements. Started in September 2019, CCN2 consists of two options led by Swiss and
Norwegian teams focusing on the investigation and definition of a new associated ECV Permafrost
product related to rock glacier kinematics. Early 2020, Rock Glacier Kinematics (RGK) has been
proposed as a new product to the ECV Permafrost for the next GCOS Implementation Plan (IP). It
would consist of a global dataset of surface velocity time series measured/computed on single rock
glacier units. A proper rock glacier kinematics monitoring network, adapted to climate research needs,
builds up a unique validation dataset of climate models for mountain regions, where direct permafrost
(thermal state) measurements are very scarce or even lacking totally. The international Action Group
Rock glacier inventories and kinematics, under the IPA (International Permafrost Association),
gathering about one hundred members, supports this integration and CCN2 is working closely with
this Action Group [RD-10 to RD-13]. Following the recommendations of this IPA Action Group, the
overall goal of CCN2 is achieved through the development of two products: (i) regional kinematicsbased rock glacier inventories and (ii) rock glacier kinematic time series of selected rock glaciers. User
Requirements, Product Specifications and Data Access Requirements are described in D1.1-1.3 of
CCN1-2 [RD-20 to RD-22]. Product Validation and Algorithm Selection, Algorithm Theoretical
Basis, End-to-End ECV Uncertainty Budget, Algorithm Development Plan and Product Validation
Plan are described in D2.1-2.5 of CCN1-2 [RD-23 to RD-27]. System Requirement, System
Specification and the System Verification are described in D3.1-3.3 of CCN1-2 [RD-28].
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This Product User Guide provides the description of the Climate Research Data Package (CRDP) of
CCN1 & CCN2 of the ESA CCI project for mountain permafrost regions, including formats, attributes
and metadata. The products required within CCN1 & CCN2 include (i) regional rock glaciers
inventories (RGI), (ii) rock glacier kinematic time series (RGK) on selected rock glaciers, and (iii) a
mountain permafrost distribution model (MPDM) in the Romanian Carpathians.
Kinematics-based rock glacier inventories, were generated by different CCI groups and external
providers according to the standards defined by the IPA Action Group Rock glacier inventories and
kinematics [RF-29 and RF-30] in different climatic regions:
• European Alpine sites: Western Alps (Switzerland), Ultental (Italy), Vanoise Massif (France);
• European subarctic/arctic sites: Troms, Finnmark (Northern Norway), Nordenskiöld Land
(Svalbard);
• Extra-European sites: Disko Island (Greenland), Tien Shan (Kazakhstan-Kyrgyzstan), Brookes
Range (Alaska), Central Andes (Argentina), Southern Alps (New Zeeland).
Rock glacier kinematic time series (RGK) on selected rock glaciers were produced based on Sentinel1 SAR interferometry, TerraSAR-X offset-tracking and feature tracking on repeat optical airphotos, in
the Swiss Alps, Norway, Svalbard and Disko Island (Greenland). In addition, trends in rock glaciers
velocity from ALOS-2 PALSAR-2 and Sentinel-1 SAR interferometry were computed in the
Romanian Carpathians.
The permafrost distribution model in the Southern Carpathians covers an area of approximately 14.000
km2 and was produced in raster format (.tiff files) at a spatial resolution of 30 m in the UTM WGS84
(EPSG: 4326) coordinate reference system.
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1 Introduction
1.1 Purpose of the document
The products required within CCN1 and CCN2 of the ESA CCI project for mountain permafrost
regions include (i) regional Kinematics-based rock glaciers inventories (RGI), (ii) rock glacier
kinematic time series (RGK) on selected rock glaciers, and (iii) a mountain permafrost distribution
model (MPDM) in the Carpathians. The Product User Guide (PUG) provides to users the description
of the Climate Research Data Package (CRDP). This includes formats, attributes and meta data.
1.2 Structure of the document
Section 2 provides the Product User Guide for the rock glaciers inventories generated by external
providers in different climatic regions.
Section 3 provides the Product User Guide for the rock glacier kinematic time series (RGK) on
selected rock glaciers, including the trends in rock glaciers velocity in the Romanian Carpathians.
Section 4 provides the Product User Guide for a permafrost distribution model at regional scale in the
Romanian Carpathians.
1.3 Applicable documents
[AD-1] ESA 2017: Climate Change Initiative Extension (CCI+) Phase 1 – New Essential
Climate Variables - Statement of Work. ESA-CCI-PRGM-EOPS-SW-17-0032
[AD-2] Requirements for monitoring of permafrost in polar regions - A community white
paper in response to the WMO Polar Space Task Group (PSTG), Version 4, 201410-09. Austrian Polar Research Institute, Vienna, Austria, 20 pp
[AD-3] ECV 9 Permafrost: assessment report on available methodological standards and
guides, 1 Nov 2009, GTOS-62
[AD-4] GCOS-200. 2016. The Global Observing System for Climate: Implementation
Needs. GCOS Implementation Plan, WMO
[AD-5] GEO/CEOS Quality Assurance framework for Earth Observation (QA4EO)
protocols 3-4
[AD-6] ESA Climate Change Initiative. CCI Project Guidelines. EOP-DTEX-EOPS-SW10-0002
[AD-7] National Research Council. 2014. Opportunities to Use Remote Sensing in
Understanding Permafrost and Related Ecological Characteristics: Report of a
Workshop.
Washington,
DC:
The
National
Academies
Press.
https://doi.org/10.17226/18711.
[AD-8] IPA Action Group ‘Specification of a Permafrost Reference Product in Succession
of
the
IPA
Map’
(2016):
Final
report.
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https://ipa.arcticportal.org/images/stories/AG_reports/IPA_AG_SucessorMap_Fin
al_2016.pdf
[AD-9] GlobPermafrost team (2017): Summary report from 3rd user Workshop. ESA DUE
GlobPermafrost
project.
ZAMG,
Vienna.
https://www.globpermafrost.info/cms/documents/reports/ESA_DUE_GlobPermafr
ost_workshop_summary_ACOP_v1_public.pdf
1.4 Reference Documents
[RD-1]

A. Bartsch, H. Matthes, S. Westermann, B. Heim, C. Pellet, A. Onaca, C.
Kroisleitner, T. Strozzi: ESA CCI+ Permafrost User Requirements Document
(URD), v1.1 12 February 2019

[RD-2]

A. Bartsch, S. Westermann, T. Strozzi, A. Wiesmann, C. Kroisleitner: ESA CCI+
Permafrost Product Specifications Document (PSD), v2.0 30 November 2019

[RD-3]

A. Bartsch, S. Westermann, B. Heim, M. Wieczorek, C. Pellet, C. Barboux, C.
Kroisleitner, T. Strozzi: ESA CCI+ Permafrost Data Access Requirements
Document (DARD), v1.0 15 January 2019

[RD-4]

A. Bartsch, S. Westermann, T. Strozzi: ESA CCI+ Permafrost Product Validation
and Algorithm Selection Report (PVASR), v2.0 30 November 2019

[RD-5]

S. Westermann, A. Bartsch, T. Strozzi: ESA CCI+ Permafrost Algorithm
Theoretical Basis Document (ATBD), v2.0 30 November 2019

[RD-6]

S. Westermann, A. Bartsch, B. A. Heim, T. Strozzi: ESA CCI+ Permafrost End-toEnd ECV Uncertainty Budget (E3UB), v2.0 30 November 2019

[RD-7]

S. Westermann, A. Bartsch, B. A. Heim, T. Strozzi: ESA CCI+ Permafrost
Algorithm Development Plan (ADP), v2.0 30 November 2019

[RD-8]

B. Heim, M. Wieczorek, C. Pellet, R. Delaloye, C. Barboux, S. Westermann, A.
Bartsch, T. Strozzi: ESA CCI+ Permafrost Product Validation Plan (PVP), v2.0
30 November 2019

[RD-9]

A. Wiesmann, A. Bartsch, S. Westermann, T. Strozzi: ESA CCI+ Permafrost
System Requirement Document (SRD), v2.0 29 February 2020

[RD-10] A. Wiesmann, A. Bartsch, S. Westermann, T. Strozzi: ESA CCI+ Permafrost
System Specification Document (SSD), v2.0 29 February 2020
[RD-11] A. Wiesmann, A. Bartsch, S. Westermann, T. Strozzi: ESA CCI+ Permafrost
System Verification Report (SVR), v2.0 31 May 2020
[RD-12] B. Heim, M. Wieczorek, C. Pellet, R. Delaloye, A. Bartsch, D. Jakober, G.
Pointner, T. Strozzi, GAMMA: ESA CCI+ Permafrost Product Validation and
Intercomparison Rerport (PVIR), v2.0 30 September 2020
[RD-13] J. Obu, S. Westermann, T. Strozzi, A. Bartsch.: ESA CCI+ Permafrost Climate
Research Data Package Version 1 (CRDPv1), v2.0 31 May 2020
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[RD-14] A. Bartsch, J. Obu, S. Westermann, T. Strozzi: ESA CCI+ Permafrost Product User Guide
(PUG), v2.0 27 May 2020
[RD-15] I. Nitze, G. Grosse, B. Heim, M. Wieczorek, H. Matthes, A. Bartsch, T. Strozzi: ESA CCI+
Permafrost Climate Assessment Report (CAR), v2.1 16 October 2020
[RD-16] T. Strozzi, A. Onaca, V. Poncos, F. Ardelean, A. Bartsch: ESA CCI+ Permafrost
CCN1 D1. User Requirement, Product Specifications and Data Access
Requirements Document, v1.0 15 February 2019
[RD-17] A. Onaca, F. Ardelean, F. Sirbu,V. Poncos, T. Strozzi, A. Bartsch: ESA CCI+
Permafrost CCN1 D2. Algorithm Development Document, v1.0 31 May 2019
[RD-18] A. Wiesmann, T. Strozzi, A. Onaca, F. Sîrbu, A. Bartsch: ESA CCI+ Permafrost
CCN1 D3. System Development Document, v1.0 30 September 2019
[RD-19] F. Sîrbu, A. Onaca, V. Poncos, T. Strozzi, A. Bartsch: ESA CCI+ Permafrost
CCN1 D3. Product Generation and Validation Document, v1.0 30 April 2020
[RD-20] C. Barboux, A. Bertone, R. Delaloye, A. Onaca, F. Ardelean, V. Poncos, A. Kääb, L.
Rouyet, H. H. Christiansen, T. Strozzi, A. Bartsch: ESA CCI+ Permafrost. CCN1 & CCN2
Rock Glacier Kinematics as New Associated Parameter of ECV Permafrost. D1.1 User
Requirement Document (URD), v1.0 30 November 2019
[RD-21] C. Barboux, A. Bertone, R. Delaloye, A. Onaca, F. Ardelean, V. Poncos, A. Kääb, L.
Rouyet, H. H. Christiansen, T. Strozzi, A. Bartsch: ESA CCI+ Permafrost. CCN1 & CCN2
Rock Glacier Kinematics as New Associated Parameter of ECV Permafrost. D1.2 Product
Specification Document (PSD), v1.0 30 November 2019
[RD-22] C. Barboux, A. Bertone, R. Delaloye, A. Onaca, F. Ardelean, V. Poncos, A. Kääb, L.
Rouyet, H. H. Christiansen, T. Strozzi, A. Bartsch: ESA CCI+ Permafrost. CCN1 & CCN2
Rock Glacier Kinematics as New Associated Parameter of ECV Permafrost. D1.3 Data
Access Requirement Document (DARD), v1.0 30 November 2019
[RD-23] L. Rouyet, T. R. Lauknes, C. Barboux, A. Bertone, R. Delaloye, A. Kääb, H. H.
Christiansen, A. Onaca, F. Sirbu, V. Poncos, T. Strozzi, A, Bartsch: ESA CCI+
Permafrost. CCN1 & CCN2 Rock Glacier Kinematics as New Associated
Parameter of ECV Permafrost. D2.1 Product Validation and Algorithm Selection
Report (PVASR), v1.0 April 30, 2020
[RD-24] L. Rouyet, T. R. Lauknes, C. Barboux, A. Bertone, R. Delaloye, A. Kääb, H. H.
Christiansen, A. Onaca, F. Sirbu, V. Poncos, T. Strozzi, A, Bartsch: ESA CCI+
Permafrost. CCN1 & CCN2 Rock Glacier Kinematics as New Associated
Parameter of ECV Permafrost. D2.2 Algorithm Theoretical Basis Document
(ATBD), v1.0 April 30, 2020
[RD-25] L. Rouyet, T. R. Lauknes, C. Barboux, A. Bertone, R. Delaloye, A. Kääb, H. H.
Christiansen, A. Onaca, F. Sirbu, V. Poncos, T. Strozzi, A, Bartsch: ESA CCI+
Permafrost. CCN1 & CCN2 Rock Glacier Kinematics as New Associated
Parameter of ECV Permafrost. D2.3 End-to-End ECV Uncertainty Budget
(E3UB), v1.0 April 30, 2020
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[RD-26] L. Rouyet, T. R. Lauknes, C. Barboux, A. Bertone, R. Delaloye, A. Kääb, H. H.
Christiansen, A. Onaca, F. Sirbu, V. Poncos, T. Strozzi, A, Bartsch: ESA CCI+
Permafrost. CCN1 & CCN2 Rock Glacier Kinematics as New Associated
Parameter of ECV Permafrost. D2.4 Algorithm Development Plan (ADP), v1.0
April 30, 2020
[RD-27] L. Rouyet , T. Rune Lauknes, C. Barboux, A. Bertone, R. Delaloye, A. Kääb, H.
H. Christiansen, A. Onaca, F. Sirbu, V. Poncos, T. Strozzi, A, Bartsch: ESA CCI+
Permafrost. CCN1 & CCN2 Rock Glacier Kinematics as New Associated
Parameter of ECV Permafrost. D2.5 Product Validation Plan (PVP), v1.0 April 30,
2020
[RD-28] A. Wiesmann, T. Strozzi: ESA CCI+ Permafrost. CCN1 & CCN2 Rock Glacier
Kinematics as New Associated Parameter of ECV Permafrost. System
Development Document (SDD), v1.0 30 November 2020
[RD-29] IPA Action Group Rock glacier inventories and kinematics, 2020. Towards
standard guidelines for inventorying rock glaciers. Baseline concepts. Last version
available
on
https://bigweb.unifr.ch/Science/Geosciences/Geomorphology/Pub/Website/IPA/Cu
rrentVersion/Current_Baseline_Concepts_Inventorying_Rock_Glaciers.pdf
[RD-30] IPA Action Group Rock glacier inventories and kinematics, 2020. Kinematics as
an optional attribute of standardized rock glacier inventories. Last version
available
on:
https://bigweb.unifr.ch/Science/Geosciences/Geomorphology/Pub/Website/IPA/Cu
rrentVersion/Current_KinematicAttribute.pdf
[RD-31] IPA Action Group Rock glacier inventories and kinematics, 2020. Rock glaciers
kinematics as an associated parameter of ECV Permafrost. Last version available
on:
https://bigweb.unifr.ch/Science/Geosciences/Geomorphology/Pub/Website/IPA/Cu
rrentVersion/Current_RockGlacierKinematics.pdf
[RD-32] IPA Action Group Rock glacier inventories and kinematics, 2020. Response to
GCOS ECV review – ECV Permafrost. ECV Product: Rock Glacier Kinematics.
Available on: https://gcos.wmo.int/en/ecv-review-2020.
1.5 Bibliography
A complete bibliographic list that support arguments or statements made within the current document
is provided in Section 5.1.

1.6 Acronyms
A list of acronyms is provided in Section 5.2.
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1.7 Glossary
A comprehensive glossary of terms relevant for the parameters addressed in Permafrost_cci is
available as part of the User Requirement Documents of the baseline project [RD-1] and of CCN 1-2
[RD-16].

PAGE 10

D4.3 Product
User Guide

CCI+ PHASE 1 – NEW ECVS
Permafrost: CCN1 & CCN2

Issue 1.0
23 December 2020

2 Regional rock glaciers inventories
2.1 Terminology
The Rock Glacier Inventory (RGI) identifies, enumerates and describes rock glaciers over a defined
area for a defined time interval. Rock glaciers are spatially identified and characterized, as described
in the Product Specification Document (PSD) [RD-21]. The kinematic attributes are assigned
following the standards described in the Algorithm Theoretical Basis Document (ATBD) [RD-24].
The RGIs are derived for the European Alps, European Subarctic/Arctic and Extra-European sites.
Rock glaciers are discriminated using the technical definition proposed by the IPA Action Group
based on aerial imagery/high resolution satellite imagery [RD-31] and/or with existing
geomorphological rock glacier inventories.
Slope movements related to rock glaciers are detected based on InSAR data. These movements are
spatially identified and characterized through ‘moving areas’, as defined in the Algorithm Theoretical
Basis Document (ATBD) [RD-24]. Slope movements not related to rock glaciers can also be mapped,
but this should be indicated in the metadata file and in the remarks attribute.
2.2 Temporal coverage
Moving areas are spatially identified and characterized using InSAR images acquired during the snowfree periods. Slow movements are identified using annual interferograms computed between two or
more consecutive summers. Fast movements are identified using summer interferograms, using time
intervals from 6 days. At least 15 interferograms are used.
Rock glaciers kinematics refer to annual velocity. Therefore, specific translation rules are followed to
derive the rock glacier kinematic attributes from the original velocity classes of the moving areas.
These rules are defined in the standards described in the Algorithm Theoretical Basis Document
(ATBD) [RD-24]. They take into account (i) the InSAR underestimation of actual 3D displacement
due to displacement being detected along the LOS component and (ii) the different temporal coverages
between moving areas (e.g. summer) and annual rock glacier kinematic attribute. This is because rock
glaciers are often faster in the summer, and by observing the displacement only during the summer,
their annual velocity may be overestimated.
2.3 Spatial coverage
Coverage depends on the sensor’s geometry. Depending on the region, two or more geometries from
ascending and descending orbits are used. However, some rock glaciers are not covered at all due to
foreshortening, layover or shadow conditions. Kinematics remains in that case “undefined”.
2.4 Spatial resolution
The applied threshold for the minimum size of a rock glacier within a RGI is around 0.01 km2. Each
rock glacier is identified by a point located within the landform perimeter.
Moving areas related to the inventoried rock glaciers are outlined with polygons based on Sentinel-1
InSAR (20-60 m final resolution). Additional InSAR satellite data and/or optical aerial/satellite
photogrammetry (1-10 m resolution) are used when available.
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2.5 Product projection system
The Coordinate Reference System (CRS) used for the RGI products is UTM, based on the World
Geodetic System 84 (WGS84) reference ellipsoid. The coordinates are specified in meters.
2.6 File format
Rock glacier inventory (RGI) format is a point shapefile, containing the location of each rock glacier
unit. The moving areas (MA) format is a polygon shapefile, containing the delineation of the detected
slope movements. The geomorphological outlines (GO) format is a polygonshapefile, containing the
delineation of each rock glacier. The associated attribute tables contain information defined by the
standards described in the Algorithm Theoretical Basis Document (ATBD) [RD-24].
2.7 Product file naming convention
The files are named as follows:
ESACCI-<CCI Project>-<Processing Level>-<Data Type>-<Product String>[-<Additional
Segregator>]-<Indicative Date>[<Indicative Time>]-fv<File version>.<extension>
<CCI Project>
PERMAFROST for Permafrost_cci
<Processing Level>
Indicator - IND
<Data type>
RGI, for the rock glacier inventory.
<product string>: <source>_<algorithm>
Source data (main input), e.g. SENTINEL1, PALSAR, PALSAR2, TSX or AIRPHOTOS
Algorithm, e.g. interferometry (INT), offset-tracking (OFF) and feature tracking (FEA), multiple
(MUL)
<Additional Segregator>: <area_layer>
This should be AREA<TILE_NUMBER> being the tile number the subset index: 5-Romania 6Switzerland, Western Swiss Alps; 7-Norway, Troms; 8- Norway, Finnmark; 9-Svalbard,
Nordenskiöld; 10-France, Vanoise; 11-Italy, Sud Val Venosta, Sudtirol; 12-Greenland, Disko Island;
13-Tien Shan; 14-Alaska, Brookes Range; 15-Argentina, Central Andes, 16-New Zealand, Central
part of the Southern Alps
<Layer>
In case that the individual layers of the vector/raster product are provided as different NetCDF files,
the code of each layer will be detailed as follows:
• RG: layer 1, corresponding to the rock glacier inventories
• MA: layer 2, corresponding to the associated moving areas
• GO: layer 3, corresponding to the optional geomorphological outline of rock glaciers
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< Reference date of the production >
The identifying date for this data set:
Format is YYYYMMDD, where YYYY is the four digits year, MM is the two digits month from 01 to
12 and DD is the two digits day of the month from 01 to 31. For monthly products DD=01. Annual
averages are represented with year only.
fv<File Version>
File version number in the form n{1,}[.n{1,}] (That is 1 or more digits followed by optional . and
another 1 or more digits). The most recent version is fv1.0 (released in October 2020).

Example:
ESACCI-PERMAFROST-IND-RGI-SENTINEL1_INT-AREA6_RG-2020-fv01.0.shp
2.8 Feature attributes
For each rock glacier in the study sites the following attributes are recorded:
- ID (a unique alpha-numerical identifier of the rock glacier unit)
- geographic location, (X and Y coordinates of the unit)
- morphological type (undefined, simple or complex unit)
- spatial connection to the upslope unit (talus, debris mantle, landslide, glacier, glacier forefield, poly,
undefined)
- activity (active, transitional, relict, undefined)
- destabilization signs visible (yes, no, undefined).
- kinematic class (Undefined, < cm/yr, cm/yr, cm/yr to dm/yr, dm/yr, dm/yr to m/yr, m/yr, > m/yr,
Other)
- Multi-year validity time frame of the assigned kinematic class
- Data type, observation time window, temporal frame and dimensionality of the data used (e.g. related
to the moving area) to assign the kinematic class
- Spatial representativeness: percentage of surface that is documented by supporting kinematic data
(Undefined, < 50%, 50-75%, > 75%)
- Reliability of the kinematic class (Undefined, Low, Medium, High)
- Remarks (e.g. to provide the kinematic information when the kinematic class “Other” is used)
Each rock glacier is linked to moving area(s) whose following attributes are recorded:
- ID (a unique alpha-numerical identifier of the moving area)
- InSAR velocity class (Undefined, < 1 cm/yr, 1-3 cm/yr, 3-10 cm/yr, 10-30 cm/yr, 30-100 cm/yr, >
100 cm/yr, Other).
- Observation time window, temporal frame and sensor type used to perform the characterization
- Reliability of the InSAR velocity class (Undefined, Low, Medium, High)
- Related rock glacier unit
- Remarks
Moving areas not related to rock glaciers can also be mapped, but this should be indicated in the
Metadata file and in the Remarks attribute.
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2.9 Meta data
Standard formatting for the meta data information (e.g. JASON file) will be prepared at a later stage.
Examples from prototypes developed in ESA DUE GlobPermafrost will be followed.
For each inventory a separate documentation file is provided building on the PUG. The
documentations include information about the satellite scenes used (date, path, row, sensor,
processing), the additional kinematic data used (used techniques, date acquisitions, points/areas
measured, accuracy, precision), the date / source / spatial resolution of the available DTM and
orthoimages, the available slope movement inventory and/or geomorphological rock glacier inventory
as well as the names of the operators and the date / region of the analysis. Of course, references to be
cited, acknowledgments and any other important metainformation are mentioned.
2.10 Known limitations
The spatial identification and characterization of the moving areas is technology-dependent.
Therefore, it is subject to the limitations from the specific technique used. For the InSAR technique
the limitations are described in the Algorithm Theoretical Basis Document (ATBD) [RD-24].
The spatial identification and characterization of a RGI aims to be technology independent and rules
for standardization have been defined to take this into account. The assignment of kinematic classes
depends on the available kinematic information (e.g. from the moving areas).
The production of deliverables for the investigated climatic regions highlighted the importance of
quality and availability of the input datasets used. The main problems found are described below.
The slow movements are investigated mainly using annual interferograms. However, using a long time
interval, the quality of the interferograms gets sometimes lower, not least due to loss of phase
coherence, and the number of suitable interferograms is generally lower than the number of suitable
interferograms with shorter time intervals. Slow movements are therefore more complicated to
analyse, and reliability is consequently lower. As result, a larger number of slow movement features
(moving areas and rock glaciers) detected with annual interferograms were classified as undefined.
In general, especially for the faster moving rock glaciers, the motion signature is sometimes very
clearly visible in the short-term interferograms. However, depending on the region, local effects such
as remaining snow, or local displacement gradients hinder the clear quantification of the velocity.
Therefore, sometimes, only a single set of interferograms could be used to define the velocity class,
which might not be representative if extrapolated over to a full year in cases where the rock glacier
undergoes strong seasonal variability in velocity.
The investigated rock glaciers are sometimes connected to other landforms, e.g. rock glaciers
connected to a debris-covered glacier in the upper part. The boundary between rock glaciers and
debris-covered glaciers is sometimes unclear, and rock glaciers may therefore be mapped together
with a debris-covered glacier. In these particular cases, the kinematic attribute was assigned but
comments about this limitation added in the remarks field of the attribute table.
Another problem was related to the availability of optical data. The rock glaciers were identified and
investigated with help of optical satellite imagery. When high-resolution optical data are not available
on the investigated area, the study of the geomorphological characteristics of each rock glacier
becomes complicated. Therefore, fields related to geomorphological characteristics (such as the
morphology of the unit, the type of spatial connection to the upslope unit, the degree of destabilization
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and the spatial representativeness) were not provided when high-resolution optical data were not
available.
In some cases, rock glaciers are too small compared to the resolution of interferograms possible, thus
preventing classification. In some cases, rock glaciers are in areas of foreshortening, layover or
shadow for both ascending and descending geometries, or creep in North-South direction that limits
the LOS sensitivity of actual displacements.
Despite the limitations described, this work has demonstrated the large potential and feasibility of
producing inventories of moving areas and kinematic inventories of rock glaciers on a global scale.
Therefore, work will continue towards product standardization, updating and improving the
guidelines.
A large number of external partners took part in the product generation. Therefore, many elements will
probably be improved / updated in the future. Standard formatting for the metadata file (e.g. JASON
file) will be prepared at a later stage. Useful information is provided with the documentation files.
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3 Rock glacier kinematic time series
3.1 Kinematic time series from optical data
3.1.1 Terminology
Horizontal displacements can be measured from repeat orthorectified airphotos or high-resolution
optical satellite data using cross-correlation techniques (Kääb and Vollmer, 2000). The results consist
of the two-dimensional horizontal displacement components. Possibility to perform such
measurements based on airphotos depends much on the availability, quality and accessibility of
suitable imagery and varies a lot from country to country. While airphotos with good quality are
accessible for instance in Switzerland and over parts of Norway, access is very complicated for
instance in Central Asia. Modern high-resolution optical satellite data are commercial and access thus
limited by finances available. Cold-war era spy satellite data from the US Corona program can be
useful but availability is variable.
3.1.2 Temporal coverage
High resolution airphotos and satellite data can be available from around the 1960s on, though highly
variable from country to country. Displacements are typically measured over time intervals of several
years, i.e. are a pluriannual average.
3.1.3 Spatial coverage
As the temporal coverage, also the spatial coverage of suitable high-resolution optical data is highly
variable and needs to be investigated from case to case.
3.1.4 Spatial resolution
Suitable image resolutions of available data ranges from a few metres (e.g. Corona spy images) to a
few decimetres (e.g. 30 cm for best satellite data, or 20 cm for modern airphotos).
3.1.5 Product projection system
The Coordinate Reference System (CRS) used for the optical rock glacier velocities is UTM, based on
the World Geodetic System 84 (WGS84) reference ellipsoid. The coordinates are specified in meters.
3.1.6 File format
Optical rock glacier velocities are provided in ASCII files with tab or space delimited columns for
point coordinates, horizontal displacement components between two dates, and measurement quality
indicators.
3.1.7 Product file naming convention
The files are named as follows:
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ESACCI-<CCI Project>-<Processing Level>-<Data Type>-<Product String>[-<Additional
Segregator>]-<date 1>-<date 2>-<Indicative Date>-fv<File version>.<extension>
<CCI Project>
PERMAFROST for Permafrost_cci
<Processing Level>
Level 2 – L2: Retrieved environmental variables at the same resolution and location as the level 1
source. Level 0 – L0: 2D horizontal displacements between two dates.
<Data_type>
RGK, for the kinematic time series.
<product string>: <source>_<algorithm>
Source data (main input), e.g. AIRPHOTOS, …
Algorithm, e.g. interferometry (INT), offset-tracking (OFF) and feature tracking (FEA), multiple
(MUL)
<Additional Segregator>
This should be AREA_<TILE_NUMBER> being the tile number the subset index: 5-Romania 6Switzerland, Western Swiss Alps; 7-Norway, Troms; 8- Norway, Finnmark; 9-Svalbard,
Nordenskiöld; 10-France, Vanoise; 11-Italy, Sud Val Venosta, Sudtirol; 12-Greenland, Disko Island;
13-Tien Shan; 14-Alaska, Brookes Range; 15-Argentina, Central Andes, 16-New Zealand, Central
part of the Southern Alps
<Reference to RGI ID>
When available, reference to the unit’s identifier from the rock glacier inventory, e.g. RG-06-0001-01.
<Date 1>-<Date 2>
Date of first and second image for which displacements are computed.
< Reference date of the production >
The identifying date for this data set:
Format is YYYYMMDD, where YYYY is the four digits year, MM is the two digits month from 01 to
12 and DD is the two digits day of the month from 01 to 31. For monthly products DD=01. Annual
averages are represented with year only.
fv<File Version>
File version number in the form n{1,}[.n{1,}] (That is 1 or more digits followed by optional . and
another 1 or more digits).
Example:
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ESACCI-PERMAFROST-L2-RGK-AIRPHOTOS_FEA-AREA6-06-0001-01_1708201118082016_2020-fv01.0.csv
3.1.8 Point attributes
For each measurement point of a file the attributes X, Y, dX displacement, dY displacement, length of
displacement, azimuth of displacement, correlation coefficient are given.
3.1.9 Meta data
Standard formatting for the meta data information (e.g. JASON file) will be prepared at a later stage.
Examples from prototypes developed in ESA DUE GlobPermafrost will be followed.
Further documentation files are provided based on the PUG. They contain the image sources and
characteristics, operator, data of production, measurement parameters, and references.
3.1.10 Known limitations
A number of factors can make optical image matching difficult or reduce its accuracy:
• Images can have low radiometric quality (low contrast, shadows), which reduces correlation
quality;
• Lack of visual contrast to match;
• Natural changes such as different snow covers or local terrain disturbances can produce
mismatches;
• Different illumination conditions and shadows can lead to mismatches;
• Geometric distortions from image acquisition, storage or scanning appear falsely as displacements;
• Errors in the DEM used for image orthorectification translate to lateral distortions and appear
falsely as displacements.
• Standard formatting for the metadata file (e.g. JASON file) will be prepared at a later stage. Useful
information is provided with the documentation files.

3.2 Kinematic time series from SAR data
3.2.1 Terminology
Kinematic time series (RGK) from SAR data are processed using Synthetic Aperture Radar
Interferometry based on Sentinel-1 images, according to specifications described in the ATBD [RD24] and following the methodology published by Strozzi et al. (2020). The SAR geometry is chosen
according to the slope orientation of the considered rock glacier (ascending for east-facing slopes,
descending for west-facing slopes). All subsequent Sentinel-1 interferograms generated. Those with
low coherence (e.g. due to snow in winter seasons) are discarded. It should however be noted that the
data availability can vary from site to site (e.g. descending geometry in Svalbard was not available
before 2018). The velocity series are generated by unwrapping the LOS phase of atmospheric
corrected interferograms. A local calibration point in an area expected to be stable is used for each
rock glacier. All values are projected along the local slope using an available DTM.
3.2.2 Temporal coverage
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Sentinel-1 data are available since 2014, but regular acquisitions are mainly available only since 2016.
The temporal interval between measurement is 6 days (12 days before 2016 and if an acquisition is
missing). The measurement period varies from site to site depending on snow conditions.
3.2.3 Spatial coverage
RGK examples currently consists in a couple of sites per study area (06-Swiss Alps, 07-Troms,
Norway, 08-Finnmark, Norway, 09-Nordenskiöld Land, Svalbard, 12-Disko Island, Greenland). The
number of documented rock glaciers is meant to increase in the future.

3.2.4 Spatial resolution
Velocity measurements document a selected pixel at each site. A 4x1 multi-looing factor is applied to
the interferograms leading to a spatial resolution of ca 20 m.
3.2.5 Product projection system
Latitude/longitude coordinates of the points are documented.
3.2.6 File format
RGK files are in csv format.
3.2.7 Product file naming convention
The files are named as follows:
ESACCI-<CCI Project>-<Processing Level>-<Data Type>-<Product String>[-<Additional
Segregator>]-<Indicative Date>[<Indicative Time>]-fv<File version>.<extension>
<CCI Project>
PERMAFROST for Permafrost_cci
<Processing Level>
level 2, 3 (L2, L3) or Indicator (IND); L2- Retrieved environmental variables at the same resolution
and location as the level 1 source, L3 - Level 2 variables mapped on a defined grid with reduced
requirements for ancillary data. Three, IND - Indicators derived from satellite data.
<Data_type>
RGK, for the kinematic time series.
<product string>: <source>_<algorithm>
Source data (main input), e.g. SENTINEL1, PALSAR, PALSAR2, TSX or AIRPHOTOS
Algorithm, e.g. interferometry (INT), offset-tracking (OFF) and feature tracking (FEA), multiple
(MUL)
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<Additional Segregator>:<AREA_INSARLEVEL>
This should be AREA<TILE_NUMBER> being the tile number the subset index: 5-Romania 6Switzerland, Western Swiss Alps; 7-Norway, Troms; 8- Norway, Finnmark; 9-Svalbard,
Nordenskiöld; 10-France, Vanoise; 11-Italy, Sud Val Venosta, Sudtirol; 12-Greenland, Disko Island;
13-Tien Shan; 14-Alaska, Brookes Range; 15-Argentina, Central Andes, 16-New Zealand, Central
part of the Southern Alps
INSAR processing level IL0 for LOS time series
• IL1 for time series in absolute velocity
• IL2 for time series in relative velocity
• IL3 regional indexes
So far, only IL0 and IL1 available.
<Reference to RGI ID>
When available, reference to the unit’s identifier from the rock glacier inventory, e.g. RG-06-0001-01.
< Reference date of the production >
The identifying date for this data set:
Format is YYYYMMDD, where YYYY is the four digits year, MM is the two digits month from 01 to
12 and DD is the two digits day of the month from 01 to 31. For monthly products DD=01. Annual
averages are represented with year only.
fv<File Version>
File version number in the form n{1,}[.n{1,}] (That is 1 or more digits followed by optional . and
another 1 or more digits). The most recent version is fv1.0 (released in November 2020).
Example:
ESACCI-PERMAFROST-L3- RGK- SENTINEL1_INT-AREA6_IL1-06-0001-01_2020-fv01.0.csv
3.2.8 Pixel attributes
The following attributes are documented for both the selected point (on rock glacier) and at the InSAR
reference location (expected to be stable):
• Latitude/longitude coordinates
• Elevation from available DEM
• Slope projected mean velocity
• LOS incidence angle and track angle
• LOS unit vector (East, North, Up)
• Slope/Aspect from available DTM
• Velocity series in m/yr projected along slopes, for acquisition dates YYYYMMDD
• LOS velocity series in m/yr, for acquisition dates YYYYMMDD (can be used in postprocessing to correct for phase unwrapping errors)
• Coherence for acquisition dates YYYYMMDD (can be used in post-processing to include or
exclude point on time series)
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Scale factor from LOS to projection along the slope (can be used in post-processing to correct
for phase unwrapping errors)

3.2.9 Meta data
Standard formatting for the meta data information (e.g. JASON file) will be prepared at a later stage.
Examples from prototypes developed in ESA DUE GlobPermafrost will be followed.
Separate documentation files are provided based on the PUG. They include information about the
satellite scenes used (date, path, row, sensor, processing), the date / source / spatial resolution of the
available DTM, as well as the names of the operators and the date / region of the analysis. References
to be cited, acknowledgments and any other important metainformation are mentioned.
3.2.10 Known limitations
The current processing chain still require to be refined. Among the current identified challenges, here
are the most important for improving the quality of the products:
• Selection of InSAR reference pixels (based on local knowledge, to account for ground
stability at the chosen location) and relevant pixels for rock glacier monitoring based on
interdisciplinary considerations (geomorphological expertise to focus on representative
sections of the landforms and SAR expertise to account for potential InSAR limitations).
• Phase ambiguity and unwrapping errors: bias must be expected, especially for fast moving
landforms. Due to small multi-looking factors (4x1), the quality of the phase estimate can be
low at specific locations. Processing tests with 8x2 multi-looking factors may be performed in
the future. With the assumption that errors may still remain, techniques to filter out outliers
due to poor quality interferograms should also be tested.
• Atmospheric corrections: time series based on short temporal baseline (6 days) of image pairs
do not benefit from a redundant network of interferograms usually used to correct atmospheric
effects.
• Coherence estimation: coherence is used to consider a new point on the kinematic time series.
Estimation window size, multi-looking and location might be optimized. In addition, if a filter
based on coherence estimate is not sufficiently robust, other approaches, e.g. using amplitude
dispersion, can be investigated.
• Standard formatting for the metadata file (e.g. JASON file) will be prepared at a later stage.
Useful information is provided with the documentation files.

3.3 Trends in rock glaciers velocity in Southern Carpathians (Romania)
3.3.1 Terminology
Rock glacier dynamics may be related to the state of the underlying or surrounding permafrost layers.
Melting conditions for the permafrost layer could translate into an increased dynamic of the rock
glaciers. Thus, both the spatial extent of the measured glacier activity and velocity values may be
quantitative indicators of the state of the permafrost layer.
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The velocity of the rock glaciers is provided as mm/year in slant-range direction. Also, the direction of
the measurement is provided, to project the slant-range direction to the most realistic direction
provided by a Digital Elevation Model or other specialist’s information, at a later time.
3.3.2 Temporal coverage
The temporal coverage of the rock glacier kinematics measurements will be every 6-12 days during
the ice/snow-off periods, with a relevant number of acquisitions per period (at least 15) in order to
form multiple combinations of interferograms, remove sub-optimal ones (high baseline, high
atmospheric effects) and still be left with enough measurements for accurate velocity estimates.
The temporal coverage of the glacier’s kinematics should be yearly (average displacement rate per
year) after 2015, assuming that in the ice-on periods the glaciers are more or less stable. Within a year,
the glacier displacement could vary with short-term climatic conditions, thus an annual average should
be more relevant.
3.3.3 Spatial coverage
Coverage depends on the sensor’s geometry. All rock glaciers in Retezat mountains are covered.
3.3.4 Spatial resolution
Spatial resolution of 100 m2 is possible in slant-range, with Sentinel-1. Taking slant-range to groundrange, a spatial resolution of around 200 m2 is possible on flat areas.
3.3.5 Product projection system
The Coordinate Reference System (CRS) used for the glaciers kinematics products is UTM, based on
the World Geodetic System 84 (WGS84) reference ellipsoid. The coordinates are specified in meters.
3.3.6 File format
All the resulting products are in raster format, .tiff files
3.3.7 Product file naming convention
The naming of the products follows the ECV naming convention.
File names:
ESACCI-<CCI Project>-<Processing Level>-<Data Type>-<Product String>[-<Additional
Segregator>]-<Indicative Date>[<Indicative Time>]-fv<File version>.<extension>
<CCI Project>
PERMAFROST
<Processing Level>
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L3 for Level 3; Level 2 variables mapped on a defined grid with reduced requirements for ancillary
data.
< Data type >
RGI, when the parameter is ‘presence of a rock glacier’ as part of the rock glacier inventory; RGK,
when the parameter is velocity.
<Product string>: <source>_<algorithm>
Source data (main input), e.g. SENTINEL1, PALSAR, PALSAR2, TSX and AIRPHOTOS
Algorithm, e.g. interferometry (INT), offset-tracking (OFF) and feature tracking (FEA), multiple
(MUL)
<Additional Segregator>
This should be AREA<TILE_NUMBER>_<LAYER>
<AREA> being the tile number the subset index: 5-Romania
<LAYER> In case that the individual layers of the vector/raster product are provided as
different NetCDF files, the code of each layer will be detailed as follows:
• RG: layer 1, corresponding to the rock glacier inventories
• MA: layer 2, corresponding to the associated moving areas
• GO: layer 3, corresponding to the optional geomorphological outline of rock
glaciers
<Indicative Date>
The identifying date for this data set:
Format is YYYYMMDD, where YYYY is the four digits year, MM is the two digits month from 01 to
12 and DD is the two digits day of the month from 01 to 31. For monthly products DD=01. Annual
averages are represented with year only.
fv<File Version>
File version number in the form n{1,}[.n{1,}] (That is 1 or more digits followed by optional . and
another 1 or more digits). The most recent version is fv1.0 (released in May 2019).
Examples:
Yearly products (2019 in this example)
ESACCI-PERMAFROST-L3- RGK-SENTINEL1_INT- AREA5-2019-fv1.0.tif
Monthly products (July 2019 in this example)
ESACCI-PERMAFROST-L3- RGK-SENTINEL1_INT- AREA5-20190701-fv1.0.tif

3.3.8 Product attributes
The following attributes will be recorded for each selected rock glacier:
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Reference rock glacier ID
Rock Glacier Kinematic Time Series (velocity values)

3.3.9 Meta data
Standard formatting for the meta data information (e.g. JASON file) will be prepared at a later stage.
Examples from prototypes developed in ESA DUE GlobPermafrost will be followed.
In addition, separate documentation files are provided based on the PUG. They indicate the
methodology used for deriving the Rock Glacier Kinematic Time Series (InSAR, optical, etc.) and the
related accuracy. Additional information regarding the velocity type (annual mean, snow-free period
mean, maximum, seasonal), and the time period of measurement should be specified. The producer
and the date of production should be indicated.
In addition, they should contain the acquisition geometry (heading, incidence angle for InSAR-based
measurements).
3.3.10 Known limitations
Standard formatting for the metadata file (e.g. JASON file) will be prepared at a later stage. Useful
information is provided with the documentation files.
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4 Mountain permafrost distribution model in the Carpathians
4.1 Terminology
The mountain permafrost distribution model (MPDM_CCI) is a classification algorithm that uses a
random forest approach (RF) to extrapolate permafrost distribution at a regional scale based on data
from local training sites. Random forest is a classification and regression algorithm that computes a
number of individual classification trees and uses each classification in order to produce high accuracy
results based on the majority “vote” of the classification trees. Because of the use of multiple subclassifications, it is, in general, a robust tool that has a low sensitivity to outliers and errors in input
data. The MPDM_CCI is implemented in the open source software R, making it easy to use for any
user. Because the MPDM_CCI model can be computationally intensive for large regions when using
high-resolution input data, it has a built-in function that allows the division of the study area in smaller
patches that can be independently classified and the merged to form the overall output. Using this
function, the model can be run on a desktop computer, although the running time increases
significantly.
The MPDM_CCI was implemented in the following steps:
a) Preparation of predictors:
• Selection of satellite image(s) that cover the entire area and are cloud free;
• Deriving indexes from the satellite images that are used as predictors along with the four
bands (R, G, B, NIR): NDVI, NDSI, NDWI;
• Deriving predictors from a DEM: Aspect, Convergence index, Curvature, Plan curvature,
Profile curvature, Easting, Northing, Gradient, Mid slope position, Normalized height, Direct
potential solar radiation, Indirect potential solar radiation, Total potential solar radiation,
Slope, Standardize height, Texture, Topographic Positioning Index, Valley Depth, Channel
network base level, LS factor, Slope height, Total catchment area, Topographic positioning
index, Terrain roughness index, Wetness index;
• Test of predictor correlation and remove highly correlated predictors.
b) Preparation of training data:
• Build training data points with presence/absence of permafrost constructed based on previous
research (ground surface temperature data from iButton data loggers, geophysical
measurements and expert knowledge of the area).
c) Running the model and production of the uncertainty map and predictor importance ranking.
d) Evaluation of the uncertainty map for any positional bias and systematic errors.
e) Evaluation of the predictor importance ranking and eliminate unnecessary predictors.
f) If necessary, make adjustments to the model and/or input data, based on steps e) and f).
g) Run the model and produce all the model outputs: permafrost extension map, uncertainty map,
accuracy assessment, predictor importance ranking.
h) Validation of results.
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4.2 Temporal coverage
The permafrost distribution model produces a map of permafrost probability extent for a unique
moment in time and it is not suited for change detection. The training data for the model in the
Southern Carpathians has been collected in the summer of 2019, and the validation data has been
collected in the spring of 2019. The date of the year in which the different data has been collected
depends on the technique used for acquisition. For the training data, a period with snow-free
conditions and minimum cloud cover was required, and for the validation data thick snow cover was
required.
4.3 Spatial coverage
The Southern Carpathians are located in a marginal periglacial environment, where the permafrost
occurrence is patchy and the preservation of permafrost is controlled by site-specific conditions. The
results, permafrost distribution map and the uncertainty map associated with it, cover the whole area
of the Southern Carpathians (approximately 14.000 km2).
The training data used for the model is based on site specific data from the Retezat, Parâng and
Făgăraș Mountains. The validation of the model has been performed in one of the study sites, the
central part of Retezat Mountains.
4.4 Spatial resolution
The spatial resolution of the permafrost distribution map and the uncertainty map associated with it is
30m. The input data that have a higher resolution, the remote sensed images from Sentinel 2, have
been resampled to 30m.
4.5 Product projection system
The Coordinate Reference System for of the permafrost distribution map and the uncertainty map
associated with it is: UTM WGS84, EPSG: 4326.
4.6 File format
All the resulting products are in raster format, .tiff files.
4.7 Product file naming convention
The naming of the products follows the ECV naming convention.
The files for each parameter and month will be named as follows:
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ESACCI-<CCI Project>-<Processing Level>-<Data Type>-<Product String>[-<Additional
Segregator>]-<Indicative Date>[<Indicative Time>]-fv<File version>.<extension>
<CCI Project>
PERMAFROST for permafrost_cci
<Processing Level>
L4 for Level 4; Data sets are created from the analysis of lower level data, resulting in gridded, gapfree products.
<Data type>
GTD, when the parameter is ground temperature at a certain depth, ALT, if the parameter is active
layer thickness, PFR if the parameter is permafrost extent (fraction), PFF if the parameter is
permafrost-free fraction, PFT if the parameter is fraction underlain by talik and PZO if the parameter
is permafrost zone, PPM is for permafrost probability map
<Product String> : <source>_<algorithm>
Source data (main input), e.g. SENTINEL2 or LANDSAT
Algorithm, e.g. MPDM for MPDM_CCI based in Random Forest approach
<Additional Segregator>
This should be AREA<TILE_NUMBER>_<layer>
<tile_number> being the tile number of the subset index: 1- global, 2-North America, 3Eurasia, 4-Northern hemisphere, 5-Romania
<layer>In case that the individual layers of the pixel product are provided as different
NetCDF files, the code of each layer (where available) will be detailed as follows:
• PP: layer 1, corresponding to the Julian day, or day of the year of detection of the
permafrost parameter.
• CL: layer 2, corresponding to the confidence level
• LC: layer 3, corresponding to the ground stratigraphy
<Indicative Date
The identifying date for this data set:
Format is YYYYMMDD, where YYYY is the four-digit year, MM is the two-digits month from 01 to
12 and DD is the two-digits day of the month from 01 to 31. For monthly products DD=01. Annual
averages are represented with year only. The permafrost distribution map is represented with year only
(YYYY – format).
Example: ESACCI-PERMAFROST-L4-PFR-SENTINEL2-MPDM- AREA5_CL-2003-fv01.0.nc
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4.8 Pixel attributes
The permafrost probability map has pixel values ranging from 0 (minimum permafrost probability) to
1 (maximum permafrost probability). The map is further classified based on the AUC validation into a
binary map with 0 for permafrost absence areas and 1 for permafrost presence
4.9 Meta data
Meta data are included in all files following the NetCDF Climate and Forecast (CF) Metadata
Convention 73.
4.10 Known limitations
none
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5.2 Acronyms
AD
ADP
ATBD
AUC
B.GEOS
CCI
CCN
CR
CRS
DARD
DEM
ECV
ESA
ESA DUE
E3UB
GAMMA
GCOS
GO
GTOS
GUIO
INSAR
IPA
IPCC
L4
LST
MA
MPDM
NORCE

Applicable Document
Algorithm Development Plan
Algorithm Theoretical Basis Document
Area Under the Receiver Operating Curve
b.geos GmbH
Climate Change Initiative
Contract Change Notice
Cardinal Requirement (as defined in [AD-1])
Coordinate Reference System
Data Access Requirement Document
Digital Elevation Model
Essential Climate Variable
European Space Agency
ESA Data User Element
End-to-End ECV Uncertainty Budget
Gamma Remote Sensing AG
Global Climate Observing System
Geomorphological Outline
Global Terrestrial Observing System
Department of Geosciences University of Oslo
Synthetic Aperture Radar Interferometry
International Permafrost Association
Intergovernmental Panel on Climate Change
Level 4
Land Surface Temperature
Moving Area
Mountain Permafrost Distribution Model
Norwegian Research Centre AS
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PE
PSD
PVASR
PUG
PVP
QA4EO
RF
RD
RGI
RGK
RS
SAR
SWE
T
UNIFR
UNIS
URD
UTM
WGS
WUT
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Permafrost Extent
Product Specifications Document
Product Validation and Algorithm Selection Report
Product User Guide
Product Validation Plan
Quality assurance framework for earth observation
Random Forest
Reference Document
Rock Glacier Inventories
Rock Glacier Kinematic Time Series
Remote Sensing
Synthetic Aperture Radar
Snow Water Equivalent
Temperature
Department of Geosciences University of Fribourg
University Centre in Svalbard
Users Requirement Document
Universal Transverse Mercator
World Geodetic System
West University of Timisoara
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